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Course Guide

There are Nine items that are to be turned in for this class.
 1. Initial Email
 2. Your Discussion Board Class Introduction
 3. 1st Image Scan
 4. 2nd Image Scan
 5. Restoration Test
 6. 1st Image Project (one project must be a restoration)
 7. 2nd Image Project
 8. InDesign Publication Template
  9. MS Word Publication Template

This course has Seven stages.  In the first four stages you are going to be learning digital imaging concepts and 
developing the skills of digital imaging.  In stage 5, your digital imaging skills will be tested as you restore and 
enhance a provided test restoration image.  In Stage 6 you will take the skills that you have learned and restore/
enhance two images.  This is where the rubber meets the road it is the meat of the course.  In the last stage of this 
course, after you complete your main image projects, you will prepare small versions of your images, specially 
tailored for two popular publication programs, InDesign and Microsoft Word.  You will then place them in 
provided templates of those programs.  You will need a total of three image for this last stage, your two images 
and a 3rd one to be used as a place holder.  The third one does not have to be restored, it just needs to have to 
correct resolution.

1. Fundamentals
a. Read Section I, Graphic Formats.
b. Read Section II, Resolution.
c. Read Section III, Printing Resolutions.

2. Scanning
a. Acquire at least 2 images for digital restoration or touch up.
b. Re-read Section III, Printing Resolutions.
c. Work through Section IV, Scanning.
d. Work through Section V, Image Setup.
e. Submit your two scans to the Shared space for grading, send email giving notice that they are 

there to be graded. See Blackboard for more details.

3. Learning to use Photoshop
a. Read and commit to memory Section VI, Photoshop Basics.
b. Work through Section VII, Photo Imaging.

In this Stage you are going to be introduced to the practical heart of Photoshop.  You are to use 
your images that you scanned to practice the concepts that you are being introduced to.  It is 
likely that your images may not be ideal for some of the concepts that you will be studying so you 
may want to use images that you take with your digital camera, or that you get from the internet.  
Section VII, Photo Imaging, should be one in which you spend considerable amount of time 
working through to get a solid understanding of how to work with Photoshop.

Course at a Glance

1) Scan Images (1 week)
2) Work through each concept presented 

in the course book, practicing them on 
your scans (3 – 4 weeks) 

3) Begin actual projects (3 – 4 weeks)
4) Place small versions of final images 

into publication templates. (1 weeks)
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4. Advanced Restoration
a. Work through Section VIII, Advanced Restoration.

In this Stage you will be learning new techniques and useful principals, combining and building 
upon the skills that you previously learned in Stage 3.  You are still in the learning stages of this 
course and all the practice work you are doing is not to be used in your final image projects.  
Your two image assignments are to begin after you complete this stage.  Therefore treat this 
Stage as you did Stage 3.

5. Complete the Restoration test project.
a. Open the file RestorationTest.psd, located in Blackboard and rename it as your name.  Restore 

the image to look like the example.  This is a very small resolution image, much smaller than 
your main projects are to be, but its size offers opportunity for quick demonstration of your 
skills that you have been learning.  This test restoration should take you somewhere between 
2 and 4 hours to complete.  Remember to save often.  Remember not to do any editing to the 
Original layer, you may need to take image from the original layer but do not alter it.

b. Submit to Blackboard for grading - Send email notification that it is ready to be graded. 

6. Restoring and Touching Up Your Images
a. Reread Section VI, Photoshop Basics again.
b. Read Section IX, Color Modes.
c. Read Section X, File Formats.
d. You are now to start the Final imaging projects.   Start from the original images that you sized 

up in Section V.  Be sure your file is setup with an Original Layer and a Working layer as was 
discussed in Section V.  Remember that only the Restoration project has to be from a scanned 
image.  The other one can be from your digital camera, or even from images that you get from 
the internet, but it must be a high enough resolution to qualify as has been discussed.

e. Throughout the restoration process you may have multiple layers but make sure that the layer 
named “Original” always stays on top and locked.  Periodically you will want to turn the top 
layer’s eye on and off to see your progress or to help give you perspective on where you were and 
where you are going with your image restoration.  In doing this you may see areas where you 
thought that you did a good job cloning but realize that it needs to be redone.  Take your time as 
you work on your restorations and enjoy what you are doing.  Take pride in your work, don’t do 
things half way but rise to meet the challenge that each image presents you with.

f. Before you begin your restorations, open the examples that I have provided in the class folder 
CIS120AF-fjohnson on the Shared Drive to see how your digital images are to be structured 
when you submit them.  Be sure that you remove all spots, scratches and imperfections, and do 
it in such a way that it is not even noticeable that work was done to it.

g. It is a good idea to submit your image projects to me for preliminary feedback before you 
officially submit them.  Be sure that they are loaded on your shared space and then send me an 
email with all your contact info outlined in the Syllabus, and the file names.

h. Submit to the Shared Drive for grading - Send email notice that they are ready to be graded. 

7. Preparing and Placing Images in Publication Programs
a. Read Section XII, Preparing images for Publication.
b. Open the publication Templates located in Blackboard, and work through the instructions given 

in the text.  Complete the InDesign one first and then the Microsoft one.
c. Submit to Blackboard for grading - Send an email notification that it is ready to be graded.
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Quick Key Short Cuts

The Following is a list of commonly used Short Cuts.  You should commit them to memory and use 
them instead of the File Menu.  Although this list is written for the PC, the short cuts are identical on 
the Mac when Command is substituted for , and Option is substituted for .

Pen Tool Short Cuts
Arrow   
Breaker  

Selection Tool Short Cuts
Add   
Subtract  
Intersect   +  

More Short Cuts
Deselect   + D
Invert   + I
Inverse   +  + I
Hide   + H
Free Transform   + T
Redo Function   + F
Fade Function   +  + F
Duplicate Layer   + J
Preferences   + K
Fill   + 
Hide / Show Palette Windows (Tab)
Change View (F)

Universal Quick Keys
Undo / Redo   + Z
New   + N
Open   + O
Close   + W
Quit   + Q
Save   + S
Cut   + X
Copy   + C
Paste   + V
Print   + P
Select All   + A
Rulers   + R

Navigation Short Cuts
Hand   
Zoom In   + 
Zoom Out   +  +  

Adjustment Short Cuts
Levels   + L
Curves   + M
Hue Saturation   + U
Color Balance   + B
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I. Graphic Formats
Vector Graphics are made up of mathematical 
equations which define the graphic and all of its 
attributes.  These equations are not the actual 
graphic but instructions on how the graphic 
is to be drawn by the computer program.   
Because of this fact, vector graphics can be 
enlarged or reduced and not lose any image 
quality.  Crisp lines stay crisp no matter how 
much they are enlarged.

Vector graphics are treated as objects and are 
also known as object oriented graphics.  The 
examples to the right show a vector graphic in 
two states.  The top one is shown with all the 
vector objects filled and stroked.  The next one 
shows the pure vectors without the fill or stroke 
attributes applied.  Notice that this image was 
constructed by placing multiple objects on top 
of each other to form a realistic image. 

A few of the more popular object oriented 
graphic programs would be Adobe Illustrator, 
and Corel Draw.  Without exception, Adobe 
Illustrator is the most professional industry 
standard.

Pixel Graphics are rectangular images that are 
made up of successive rows of pixels.  A pixel 
graphic can be compared to a large work of art 
made up of a grid of multicolored tile.  Each 
pixel has a particular color and when viewed 
as a whole, forms a cohesive image. A digital 
photograph is a pixel graphic.  Digital video is 
a series of pixel graphics that have the illusion 
of movement. Whereas vector graphics can be 
thought of as drawings or lines, pixel graphics 
can be thought of as being more like paint or 
tile.  Unlike a vector graphic, pixel graphics 
become “pixilated” when enlarged.  Notice how 

pixilated the shirt button looks when it is multiplied 14 times. 

Some of the more popular Pixel editing graphic programs are Adobe Photoshop, Paint Shop Pro 
and Corel Paint.  Adobe Photoshop is by far the best photo imaging program on the market, with 
almost no competition in any area of operation.
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II. Resolution
Scanning Resolution has to do with Samples Per Inch – (spi)
Images Resolution has to do with Pixels Per Inch – (ppi)
Screen Resolution has to do with the Pixel Aspect Ratio – (par?)
Printing Resolution has to do with Dots Per Inch – (dpi)

Scanning resolution has to do with how many samples the image 
being scanned is divided into. If the resolution is high then the 
grid of samples is fine, thus yielding greater image detail as well as 
a larger file size, and vice versa. 

The example to the right shows an image that has been divided 
into a grid of samples.  Each cell in the grid represents a sample 
from which a pixel will be derived based on an average of the 
sample’s overall color.

If the example to the right were an inch wide, then the 28 samples 
that it is divided into would make it 28spi.

Image Resolution has to do with how many pixels are in an image 
and, if it is to be printed, how many of an images pixels it takes to 
fill an inch.  The digital image to the right has a resolution of 28 x 
32, and, unless it is changed in Photoshop, will stay set at an inch 
wide leaving it 28ppi.

A digital image can be resized without changing the pixel ratio 
or the file size.  For example, if the image were stretched from 
covering 1 inch to covering 2 inches, the resolution’s pixel ratio 
would remain at 28 x 32 but the ppi would drop from 28 to 14.  
This is because the 28 pixels that once covered 1 inch have now 
been stretched out to cover 2 inches. 14p x 2 inches =28ppi.

Screen Resolution.  You may have heard it said that screen resolution is 72 dots per inch.  That is a 
misnomer.  At one time it may have happened to have been equal with that measurement, but today how a 
computer displays its screen output works entirely off of the size and capacity of the monitor and the chosen 
pixel format ratio.  Monitor sizes exist from smaller than 15 inches to larger than 22 inches.  For video 
projection systems, screen sizes can be more than 30 feet wide.  It is for this reason that we do not measure 
screen resolution in distance i.e. dots per inch, but in pixel aspect ratios.  Pixel aspect ratios vary dramatically 
depending on the age and technology of the monitor and the platform of the monitor, i.e. Mac vs. IBM.  
Common pixel ratios would be 640 x 480, 600 x 800, 1024 x 768, etc.  The higher the number, the higher the 
resolution and the smaller objects look on the screen.  The lower the number, the lower the resolution and the 
larger the windows and Palettes become, leaving less room on the screen  (It is a good practice to work at the 
highest resolution that, both you and your monitor can be comfortable with).

Print Resolution has to do with the quality of the printing, how many dots per inch can be printed.  For 
instance the new Epsons can print at a resolution of 2880+ dpi.
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III. Printing Resolutions
The first thing that must be taken into consideration when preparing an image is its intended destination.

Is it intended for monitor viewing on the World Wide Web or perhaps TV Video?
Is it going to be printed on a personal ink jet printer?
Is the destination a black & white laser printer in your office?
Is the intended output a color laser copier at the local print shop?
Is it meant for a magazine or newspaper publication on a printing press?

Each output has its own requirements when it comes to image resolution (ppi).
•	 Images being prepared for the web must be according to exact pixel dimensions.  If the image is 

suppose to occupy a space that is 200 x 154, then the image must be 200 pixels wide and 154 pixels 
high. (Even though images can be resized by using HTML it is best to make the image the correct 
size in Photoshop.  Download time and image quality are at stake.)  Images being prepared for video 
need to be done so with respect to the current aspect ratio which is currently 4 x 3.   A suitable pixel 
dimension would be 640 x 480 for SVGA quality.

•	 Images being prepared for ink jet printers result in a decent image quality at 150ppi; however, it is 
recommended that the resolution be at least 200ppi, and 300ppi if the computer can handle it.  There 
are many good ink jet printers to choose from on the market today.  Among them are Epson, Epson 
and Epson.

•	 Images being prepared for modern B/W laser printers, should be at least 150ppi; 200ppi would be 
better, and 300ppi would be best.

•	 If the image is being prepared for a color laser copier the resolution should be at least 250ppi; even 
300ppi or higher would be good.

•	 Images that are intended for a traditional printing press need to be prepared with an understanding of 
the printing process called Line Screen.  Line screen refers to how many rows of half tone black dots 
are in an inch.  There are three main grades of line screen, though your service bureau may use one not 
listed, it is always best to check:

1. Newspaper quality, 85 lines per inch
2. Magazine quality, 133 lpi
3. Art print quality, 166 lpi

 Most printing is done at the magazine quality of 133 lpi.  The way that it works is the image is divided 
into its four primary print colors of Cyan, Magenta, Yellow and Black (CMYK).  Each color division 
of the image gets re-represented through the line screen, each having its own angle.  The goal of finding 
the best ppi lies between having the image at a high enough resolution that the image looks good when 
re-represented through the line screen, and at the same time is not so big of a file size that it becomes 
counter productive, hindering efficient workflow.  There are many theories that exist on how to arrive 
at the best ppi; among them are

  133 lpi  x  1 1/2 = 200ppi
  133 lpi  x  2 = 266ppi
  133 lpi  x  2 1/4 = 300ppi
 It is my personal recommendation that images that are intended for the printing press be at least 300 

ppi, if not higher.  Use the lower figure of 266ppi if there is no other choice.
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IV. Scanning
The trick to scanning is “understanding what your final image destination is going to be.”

•	 Will it be print, web or video?
•	 Will it be Color, Black & White (Line Art) or Gray Scale?

What target resolution, or pixels per inch, will it have to be?
The answers to these questions, and more, will determine how you will scan your image.

Rules of Thumb
•	The first rule of thumb is to start with a good quality image.  If your picture or artwork is blurry, grainy or poorly 

exposed, it will be evident in the scan.
•	Secondly, be sure to choose images that are large enough for the intended purpose. Don’t expect to scan somebody’s 

face in a group photo and have it look good when you enlarge it to fill the entire canvas.
•	When at all possible, it is better to scan a photograph, which has fine grain, rather than an image that has been 

printed in a magazine, which is composed of relatively rough course dots. (Look at a printed magazine image under 
a magnifying glass and see how big those dots really are.)

It all starts with a photo.  Next, a determination is made as to how to 
crop it, as scanning is not limited to the dimensions of the photo itself.  
See the example to the right.  Let’s say we want to scan an area close 
to the subjects that is roughly one inch horizontal.  We also want this 
area to end up at an established dimensional standard of 8x10 inches.  
The resolution should also end up at or above the industry standard of 
300 pixels per inch (ppi).  In order to do this we must find out what 
resolution to scan the original image at so as to end up with the correct 
resolution for an 8x10.  To do this we use the given information to 
determine this resolution.  

The relevant size information in scanning for our example is:
a. the horizontal 1 inch area, we want from our Source, and
b. the horizontal 10 inch area, we want for our Target.
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For this example, we want our 1 inch image to become a 10 inch image.  If we were to simply 
scan the image at 300 samples per inch (spi) it would be a straight across image of 1 inch 
long at 300ppi.  If this scan were then stretched to be 10 inches wide, the resolution would 
correspondingly be reduced to 30ppi, which is not the 300ppi or above that we’re after.  This 
is because the 1 inch image at 300ppi = 300 total pixels in width.  If you take and stretch those 
300 pixels over 10 inches then only 30 pixels are covering each linear inch.  So in order to 
compensate for the additional pixels required, we need to multiply the scanning resolution.  We 
do this so that the scanned image’s resolution is equal to the total number of pixels required 
by the horizontal 10 inch target.  This is done by figuring out how many times our Source 
horizontal measurement (1 inch) goes into the Target horizontal measurement (10 inches).  In 
this example that would be (1 inch into 10 inches=10 times).  So we multiply our original base 
scan of 300 by 10 and we get 3000spi.

Once you have your exact scanning resolution it is always better to round it up to give yourself 
a margin of error so as to end up with a little more pixels than necessary rather than a little 
less than 300, which would mean having to rescan.  A final target resolution of about 300ppi – 
340ppi is acceptable.

Image Size Dialogue Box
An easy way to determine the scanning 
resolution is to:

1 Take your cropped measurement 
from your with a ruler.

2 Go to Photoshop and create a image 
with the target dimensions 8 x 10 at 
300ppi.  File > New.  (   + N ).

3 Go to the Image Size Dialog Box      
(   +   + I ), make sure that 
resize check box is NOT checked, 
and enter the value of your source 
measurement in the inches area.   This 
will cause the resolution value to 
adjust accordingly and will result in 
the exact resolution that you need to 
scan the image at.

4 You will want to round it up some to 
give yourself a margin of error and 
then write it down on a piece of paper 
to refer back to when you scan.

Using the example given take one of your photographs, measure the area that you want to scan 
with a ruler, and figure out the resolution it needs to be scanned at.
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Scanning Procedures
1. In Photoshop, go File > Import
2. Set settings
3. Hit Preview
4. Define area to scan – crop area.
5. Hit Scan
6. Back in Photoshop test the resolution.

1. Because there are so many different Scanning software programs the principles of scanning will be 
given instead of detailed instructions.  Make sure that the scanner is turned on and is clean, then 
place your photograph on the scanning bed.  In Photoshop go File > Import and choose your 
scanner, this takes you out of Photoshop and into the scanning software, which is separate from 
Photoshop.  Beware at this point because some scanning software defaults to an autoscan mode that 
you need to stop and set on manual or professional mode.

2. When the Scanning software launches, the scan window will usually display the previous session’s 
last scan.  Don’t worry about it.  The first thing that you will do is place your image to be scanned 
face down on the scanner (or if it is a transparency you will put it in its proper place).

3. Now set the type of scan that you are performing.

•	If it is a photograph or some type of image printed on paper make sure that the option 
is set to Flatbed.

•	If it is a negative then set it to Negative.

•	If it is a slide then set it to Positive or Transparency.

4. Set the scanning options to reflect a Color Photo.

5. Find the resolution area and plug in the number that you came up with earlier (Do not put the 
number 300 in the area, your number will be something between about 400 and 3000), the smaller 
your crop area, the larger the number will be.  (You should also round your number up to the 
nearest increment offered by the scanner, for example, instead of 476, use 500)

6. You will now look for and press the “PREVIEW” button.

7. After the preview is finished, find the button that represents the marquee tool and mark out the area 
that you want to scan.  It usually looks like a square box drawn with a dotted line.  When marking 
out an area to be scanned, it is important to keep in mind the overall shape that you want to end up 
with.  If you fail to do this step before you hit the scan button you will end up scanning the entire 
flatbed area and it will be a very large file with a bunch of white area for most of the scan.

8. Some scanning software allows you to set what I call multipliers.  Make sure that these are set to 1 to 
1, or at 100%.  In other words we do not want the machine to further multiply your resolution.

9. Most scanning software usually has an auto exposure setting that is fine to have on, but you usually 
do not have to mess with any of the additional adjustment settings, you will be doing that later in 
Photoshop.

10. You should now be ready to hit the Scan button. This will scan what you have selected at the 
settings that you have specified and will bring it into Photoshop.

11. Once the image is in Photoshop you should proceed immediately to the next section: 
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V. Image Setup
In editing an image it is a good practice to begin by establishing the proper image size. Hopefully you 
did most of the cropping of your image when you scanned it.  If not, you can still work with what you 
have to get the desired aspect ratio.

You will be using the following Tool and Dialog Boxes to attain the proper image size. They are:
•	 The Crop Tool
•	 The Image Size Dialog Box
•	 The Canvas Size Dialog Box

We will begin with the Crop Tool  which is located on the tool bar.

You may now crop the image with more exact precision to include what you want and to exclude 
what you don’t want.  Be careful though, as you can cut away part of your image that you may need 
to fill a desired aspect ratio.  It is therefore suggested that you use the crop tool to designate exactly 
one of the dimensions and to make the other one greater in length so that it can be cut away later by 
another function.  To use the Crop Tool, click and drag from the top left area down to the bottom 
right area.  Use the little handles that appear at the corners and mid-points of the crop area to fine-
tune your crop.  When you feel that you have a good crop area defined, you can then execute the 
crop, by doubling click in the crop area but not on the center axis point.

You will now use the Image Size Dialog Box, found under Image > Image Size (  +  + I), to 
assign the proper size, in inches, to the one dimension that you choose to crop for. 

1. Make sure that the check box for Constrain 
Proportions is checked.  Make sure that the 
Resample Image in NOT checked.

2. Set the particular dimension that you cropped 
for in the previous step to the correct length in 
inches.  For example if you were working on 
an 8x10 portrait and you had cropped for the 
longer side, you would set the height to 10.

If your resolution automatically jumps to around 
300 pixels per inch, then you know that you scanned 
correctly.  If it is lower than 300ppi or significantly 
higher than 300ppi, go back and scan your image 
again and try to account for the difference in the 
new multiplication so that you end up with an image 
that is at, or moderately above, 300ppi.

Click OK when you are finished.  You should notice that your image does not look any different than 
before we changed the image size.  This is because we did not change the pixel dimension, only the size 
of the area that the image will print on paper. (If you do not understand this, go back and re-read the 
section on Resolution – Image)
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Now that you have exactly set one of the dimensions, you can trim or expand the other one using the 
Canvas Size Dialog Box, which is found under Image > Canvas Size.  Before you do this however 
it would be best to make the Background layer of the image in the Layers palette into a transparent 
layer instead of a background layer.  Simply double click on it to do this and hit OK.

(NOTE: Your image does not have to be an exact 8 x10.  Just make sure that you are maximizing the 
area of the 8 x 10 as much as possible.  If your image is already the exact crop that you desire then 
skip the Canvas Size Step.)

The Canvas Size Dialog Box allows you to cut off, or add to, the overall size of the image.
1. First, make sure that the measurements are in inches.  

If it does not say inches, hold down the bar and change 
it to inches as is shown to the right.  Do this for both 
bars.  You will now type in the exact dimension for the 
one that you did not do in the Image Size Dialog Box.  
In the example of the 8x10 portrait, the height was set 
to 10 in the Image Size Dialog Box.  In this step the 
width is trimmed down to 8.

2. Next you will choose how you want Photoshop to add 
to, or cut from, the image by choosing an appropriate 
Anchor.  Photoshop applies the function of Canvas 
Size to the opposite side that is chosen as the Anchor.  
In other words, if you chose the top middle Anchor, 
Photoshop would not touch the top of your image but 
would either add to, or subtract from, the bottom and the sides of the image according to the 
measure of your input.

Click OK when finished.  Look at the image to see what happened.  Go into the Image Size Dialog 
Box to see what the dimensions are.  In my example, the dimensions would be 8x10.

Creating an “Original” Layer
Now that the image is all squared away you will modify the file to make it ready to practice 
imaging concepts.  You need two copies of the image layer, one on top that you will name 
“Original,” and one underneath that you will name “Practice.”

1. Duplicate the layer by dragging it to the New Layer icon  
at the bottom of the palette.

2. Double click the names of the layers and change the top to 
Original, and the bottom to Practice.

3. Right click on the eye of the top layer and choose a color 
for it.  The color is to designate it as the original layer and is 
meant to warn you not to modify it.

4. Lock the top Original layer by first targeting the layer and 
then selecting the Lock ikon located near the top of the 
Layers palette.

5. Turn off the eye of the Original layer so that it is no longer visible.  Only the Practice 
layer should be visible now. (They both look the same, so to see that only the practice 
layer is visible you can turn of its eye as well and then turn it back on.)

6. Save your file as a PSD to your work location, File > Save As...
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VI. Photoshop Basics
The trick to Photoshop is understanding its philosophy.  Photoshop is simply the Selection and 
Manipulation of pixels.  The way that you work in Photoshop is

•	 You get an idea of what you want to do.
•	 You define a selection of the pixels you want to manipulate.
•	 Then you apply the function or process to those pixels that are selected to get the desired result.

Things to remember in Photoshop
•	While working in Photoshop you will want to make special use of the Undo/Redo option  

(   + Z).  This will allow you to undo the last thing you did.  To go back multiple steps, use 
the History Palette to return to a specific step in your process. (You can only go as far back as 
memory will allow).

•	Learning how to navigate in Photoshop is critical for free-flow working.  This is especially true 
with view and zoom navigating.  Make it a habit NOT to use the Zoom or Hand Tools that 
are located in the Tool Bar.  Instead, in whatever operation you are in, simply hold down the 

 while placing your mouse over the image to get a quick Hand Tool.  If you are 
zoomed in close, this will allow you to click and drag the image so you can view other parts of 
the image.  If you also hold down the    Key you will get a quick Zoom In Tool that will 
allow you to then zoom in with the click of the mouse.  If you need to zoom out, just add the  

 Key to the  and the    Key and you get a quick Zoom Out Tool.  
PRACTICE THESE NAVIGATION TECHNIQUES NOW! - Do not navigate in Photoshop 
without using these techniques.

•	Learn the Quick Keys. Using the File Pull Down Menus to perform operations is fine, but you 
really should learn the Quick Keys for those operations, especially the ones that you use the most.  
Most of the Quick Keys are displayed next to the operation in the Pull Down Menus themselves.

•	Save Often – Computers crash and you don’t want to loose all your work. (  + S)
•	You are going to see a lot of Palettes that are rather cluttering and take up a bunch of visual real 

estate.  You can arrange the Palettes by dragging and dropping them in other groups.  The only 
Palettes that you really need to have open are:

	History
	Layers, Channels, Paths  – in one group

•	Learn to use the Help feature in the program; it offers a wealth of information.
•	In many functions and tools, holding down one or more of the keys Shift, Alt, and/or Control, 

may add functionality to an operation, tool or process.

Troubleshooting
If you are trying to perform a function and it just is not doing what you know it should do, here is a list of 
the most likely problems to trouble shoot for.

1. Is there a selection active that I am unaware of that needs to be deselected? It may be hidden.
2. Am I in the quick mask mode, do I need to be out of it?
3. Am I in an operation that needs to be applied or canceled out of?
4. Am I in the correct target layer?
5. Am I in the correct target channel?
6. Is there a path layer selected when it should not be?
7. Am I in an incorrect color Mode for my function to work?  Should I be in the RGB mode instead of 

INDEXED or even CMYK?
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A Few Basics About the Layers Palette
The Layers Palette is one of the most used.  It should be kept 
active. The example below helps us to understand various 
features of the Palette.
1. All layers have the capacity for transparency except 

the Background.  The Background is solid having no 
transparency and can only exist on the bottom of the 
layer stack.  If the eraser is used on the Background it will 
replace the pixels with whatever the background color is 
on the Tool bar.   An image file does not have to contain a 
Background.  The Background can be converted to a regular 
layer by double clicking on it. 

2. In the example to the right, Layer 1 is a normal layer, but has a mask associated with it.  Layer 
Masks are one way to control the layer’s transparency.  Whatever is white will be 100% solid 
(opaque).  Whatever is Black will be 100% transparent (invisible).  Whatever is 50% gray will be 50% 
visible etc…  Layer Masks are edited by targeting the mask’s thumbnail, which is to the right of the 
layer’s thumbnail.  To edit the layer’s pixels you must directly target the layer’s thumbnail, which is to 
the left of the Layer Mask thumbnail.  You will notice that in our example there is a link in between 
the Layer and the Mask.  This link keeps the layer and the mask securely related to each other.  
Clicking on this link would unlink them and allow the Mask and the Layer to move independently 
of each other.  Clicking in that spot again would re-link the two.  Layer Masks are very useful in that 
they allow you to use the paintbrush to make parts of the layer’s image transparent without deleting 
the actual image.

3. Layer 2 is linked to the text layer above it. 
4. Set 1 is a Layer Set, a folder in which multiple layers can be placed to organize and save 

space.
5. The layer called Levels 1 is not actually a layer, but an Adjustment Layer that acts as 

a filter affecting all layers underneath.  Adjustment Layers are a great way to perform 
a function such as Levels or Curves on an image without actually having to apply the 
permanent degradative function to your image.  With an Adjustment Layer you can 
repeatedly go back and tweak the adjustment without degrading the image as you would 
if you repeatedly applied a levels adjustment over and over again.  The menu to the right 
is used to choose the desired Adjustment Layer.  Levels, Curves, Color Balance, and Hue 
Saturation are the ones that you should be very familiar with.

6. On the bottom of the Palette are six icons as follows: Add Effects , Add Layer Mask , Insert 
Set , Insert Adjustment Layer , New Layer , Trash .  If a layer is dragged to the New 
Layer  Icon, the layer will be duplicated.

7. Notice the check boxes in the Lock section .  The first one locks the 
transparency value of all the pixels on the layer.  The second one locks the layer from being edited 
and the third one locks the layer from being moved.  The last one locks everything.

8. The Bar that currently says “Normal” controls how the layer blends with the underlying layers.
9. The  controls the opacity/transparence of the whole layer.
10.  More options are available by clicking the  Icon.  Notice among the choices are

a. Merge Linked – which merges all linked layers associated with the target Layer
b. Merge Visible – which merges all the visible layers, all those that have the eye turned on
c. Flatten Image – which flattens all the layers, discarding the non-visible ones, those with the eye 

turned off.

Take time to carefully familiarize yourself with the Layers Palette as it is so important.
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A Few Basics about the Channels Palette
The Channels Palette is another Palette that should always 
be active as it is at the heart of Photoshop.  Most users of 
Photoshop shy away from using the Channels for fear or 
ignorance of what they are or how they work.  You have 
already been introduced to this Palette when you began 
learning about Masks.  Understanding Masks and Channels 
is most critical.   It is what separates the casual novice user 
(who might think they are a Pro) from an experienced Digital 
Imager.
1) In the example to the right we see the special channels that 

make up the Color Mode (In this case it is RGB).  The 
very top channel is a composite of the color Channels.  
You can edit individual Channels by targeting them.

2) Any additional Channels, except the “Quick Mask” are 
called Alpha Channels.  There are two alpha channels represented here with the names 
“Quick Mask copy” and “Quick Mask copy 2.”  These are permanent Channels that (in 
this case) were derived from duplicating previous Quick Masks.  In essence they are 
saved selections that can be loaded at anytime.  Creating a selection can be a very time 
consuming process, so it is important to know that you can save your selections as an 
Alpha Channel for future use anytime you want.  You do not have to recreate it.

3) The Channel Palette icons are as follows:  loads currently targeted Channel as active 
selection,   converts current selection into a permanent Alpha Channel,  creates 
new blank Alpha Channel, and duplicates Channels that are dragged to it,  deletes a 
targeted Alpha Channel.

4) We also see an active Quick Mask Channel, which is also targeted.  We know that it is 
active because it is italicized.  If it were a regular Alpha Channel with the name of “Quick 
Mask,” it would not be italicized.  As soon as the Quick Mask Mode would be exited this 
mask would become the active selection and the Quick Mask Channel would disappear 
from the Channels Palette.

For more information on Color Modes and RGB refer to the section on Color Modes, and the 
section on Color Correction

The Options Palette
The Options Palette is a dynamic 
bar horizontally position on the top 
of the canvas.  It displays settings for 
the current tool in use, object being targeted, or function being carried out.  You can use this 
palette to modify these settings. 



CIS 120AF Photoshop - 17

VII. Photo Imaging

Brushes and Color Picker
Open one of your images and target the bottom Practice Layer.

Much of Photoshop has to do with the use of Painting and Editing 
tools that work through Brushes.  Brushes are mini masks that can be 
thought of as nozzle tips through which you manipulate pixels using 
your mouse.  They can be any shape or size and can have all sorts of 
effects associated with them.  You can even create your own uniquely 
shaped brushes, but for this class you will be using a round style brush 
in which you specify its Diameter, which is the size of the brush, and 
its Hardness, which is the to fit the particular edit’s requirements.  To 
modify your current tool’s brush’s shape and size, simply right click 
anywhere on the image area.  A quick Brush palette will appear for 

you to modify your current brush.

Photoshop has an additional massive Brushes Palette that can be accessed from the file menu 
Windows > Brushes.  This Brush Palette is very impressive and offers many features that can be very 
useful especially if you are artistically inclined.  However, for this class at least, you only need access to 
the brush’s Diameter and Hardness sliders as was discussed above.

•	 Take time now to experiment changing the brush size and softness.  Use the Paint 
Brush tool  to paint each variation of the brush that you come up with. Do this until 
you become well acquainted with the process.

Color Picker
Photoshop has two active colors at all times, Foreground 
and Background.  These colors are represented in 
the Tool Bar.  To change either the foreground or 
background color click in the respective slot, and the 
Color Picker window will appear.  To choose a color 
you simply click in the large square area on the particular 
color that you want.  The color filled slider is used to set 

the initial value for the color represented in the square area.  If the 
radial button “H” is selected (as it is in the figure to the right) then 
it is used to set the Hue.  If the “S” radial button is selected then 
it is used to set the Saturation. If the “B” radial button is selected 
then the slider is used to set the Black value. (For the sake of this class do not be concerned with the 
other radial buttons. Practice changing the Foreground and Background colors)
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Selections / Masks / Channels
In a previous section the philosophy of Photoshop was given.  Do you recall what it is?  Just in case 
you have forgotten here it is again: “Photoshop is simply the Selection and Manipulation of pixels.”  
It sounds simple, and it is, yet at the same time you can get into some pretty complex selections 
compounded by a series of intricate adjustments to attain a particular desired effect.

In the rest of this section we will be discussing Selections followed by Manipulations.

Selections are areas that you define for manipulation.  They are marked by dashed black and white lines 
that are moving to help define their position.  These moving lines are called Marching Ants.  They are 
actually more than they appear to be and will be discussed further on the next page.  There are several 
ways to make a selection, including using the Selection Tools.  The most useful Selection Tools are as 
follows:

 Rectangular Marquee Tool

 Elliptical Marquee Tool

 Lasso Tool

 Magic Wand Tool

Take time now and play with these tools to see how they behave.
Each tool has its own set of options in the Options Palette.  
Be sure that the “Anti-alias” box is checked for each tool, with 
the exception of the Rectangular Marquee Tool.  Not having it 
checked will cause your selections to appear choppy and harsh 
instead of smooth and natural.

A very useful feature to be aware of is the ability to get the flip side, that is, the exact opposite of your 
selection by using the inverse command.  To do this simply go to Select > Inverse (  +  + I).

Three kinds of functionality can be added to Selection Tools by combining them with quick keys.
•	The  key allows you to add to an existing selection.  You will notice a (+) sign added to the 

selection tool icon on the mouse pointer.
•	The  key allows you to subtract from an existing selection.  You should see a (-) sign in the 

selection tool icon on the mouse pointer.
•	The  +   held together at the same time allows you to refine your selection to get only 

the intersection of the preexisting selection and the one being made while these keys are held 
down.  You will notice an (x) sign added to the selection tool icon on the mouse pointer.

Take time now to become well acquainted with how these new keys add functionality to your 
Selection Tools.  Use all four tools discussed to create an intricate and well developed selection. 

5 ways to make selections

1. Selection tools
2. Mask editing / with pixel editing tools
3. Layer selections / based on Transparency
4. Channel selections / based on Tonal Range
5. Path selections / based on Path
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As you are just being introduced to selections it would be deceptively easy for you to imagine that a 
selection is an area marked out by a line of Marching Ants, but this is not so.  A selection is actually 
a Grayscale Mask.  Through this mask pixels are manipulated.  A grayscale image has 256 levels 
of gray ranging from 100% black to 100% white.  A grayscale image is what we might commonly 
think of as a Black & White photograph. When you make a selection using the Selection Tools, what 
you are actually doing is defining a grayscale image.

That is a lot to take in for a beginner, so read it a few more times until it starts to sink in.

Now that you know that selections are actually grayscale images, it might be a bit easier to understand 
that the “Marching Ants” are only a rough guide to show you approximately where the 50% gray value 
has been crossed in the grayscale image that is being used as a mask.  The Marching Ants are not 
always a straightforward representation of what the mask really looks like.

To begin to understand Masks and how they work, make a selection using the Selection 
Tools.  For example, select the outline of a person with the Lasso Tool and then click 
on the Quick Mask icon as is circled in the example to the left.  You should now see 
the selection represented as a mask.  The mask has a red default color but it is actually 
a grayscale image.  Access to the Channels Palette is required to see it in its pure 
grayscale state. (To show the Palette, go to the file menu Window > Show Channels.)

You should see something like this: >

What you are seeing is all the color channels that, when compiled, make 
the RGB color that you see.  You will also notice that the bottom channel 
says Quick Mask in Italic type.

(Note: All channels are grayscale images.)

Click on the RGB channel’s eye; it will turn off the image so that you 
are left with only the Quick Mask showing.  You should now see your 
selection as a pure grayscale.

A mask is a grayscale image that masks things off.  It 
is similar to masking tape.  Whatever is masked off 
will be left untouched by any manipulation that is 
performed through the mask onto the image.  However, 
with Photoshop a mask is not as restrictive as masking 
tape, as it can mask things off in percentage and not 
just in whole.  In other words, different areas can be 
masked off at different percentages.  The percentage 
of masking is determined by the darkness of the tone.  
Pure black is 100% masked off.  Nothing in this area will 
be manipulated.  The lighter the tones become the less 

masked off the area is and the more it will be affected by a manipulation.  Pure white is 0% masked 
off and everything in this white area will be affected by 100% of a manipulation. (It is possible to set 
the properties of the mask options to work in exactly the opposite mode.  In this case white would be 
the marked off area and black would be the effectible area.)  Understanding how masks work is a little 
confusing at first, but with practice, the concept becomes clear.  Understanding Masks/Channels is 
crucial to understanding Photoshop. 
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Before you entered the Quick Mask Mode you used the Selection Tools to make and edit 
the selections.  Now that you are in the Quick Mask Mode, and are viewing the selection 
as a grayscale image, you will edit the selection using pixel editing tools. Use the Paint 
Brush Tool  to begin defining your selection.  Use various shades of gray ranging from 
black to white.

To change the color/gray value of the paint, 
click on the Foreground Color box in the 
Tool Bar.  The Color Picker window will 
appear in which you can choose your color. 
(Note: because you are in a gray Quick 
Mask Mode, whatever color you choose 
will be reduced to its black and white 
equivalent). Also try using different brush 
sizes and hardness settings.

After you are finished painting your mask, exit the Quick Mask Mode by clicking on the 
icon just to the left of the Quick Mask icon as is circled to the right. 

Now that you are out of the Quick Mask Mode, and viewing your original image, you can see how 
what you painted with black, white and grays has changed the shape of the map of Marching Ants.

The above figures represent the Marching Ants, before and after Quick Mask Editing

Repeat this process of making selections with the Selection Tools and then editing them in the Quick 
Mask mode in red (so you can see how the mask relates to the image as you are editing it), and then 
in the grayscale view until you become comfortable with the process of how to edit Masks and how 
they behave.  After you make and modify your selections, and have exited the Quick Mask mode, do 
something with them like applying a filter or some other effect so that you can see how the selection 
relates to the actual image that you are working with.

Be sure to work through these concepts and not just read them.  Practice making selections using 
both the Selection Tools and the Pixel Editing Tools in the Quick Mask Mode.  Do this until you 
have a solid understanding of selections and Masks. 
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Manipulations / Adjustment Layers / Layer Masks
Now that you have learned how to make and edit selections, you will learn how to perform 
meaningful manipulations and adjustments, through those selection masks, onto your image.

Adjustment Layers are special “filter” layers that range in 
kind and are often used with Layer Masks to control the 
intensity of the effect that the Adjustment Layers have on 
various parts of the underlying layers.

Levels, Curves, Color Balance, Hue/Saturation and 
more are among the many types of Adjustment layers that 
are available.  These Layers are like living filters that can be 
modified, toggled off and on, or removed at any time. They 
affect all layers over which they are placed and they can be 
joined to a single layer in order to affect only that layer.  
They are not permanent, but can be permanently kept in 
the file or they can be merged with the effect underlying 
layers to be made permanent.

To insert an Adjustment Layer: 
1 target the layer that you want to adjust,
2 click and hold down the half moon icon  located on the bottom 

of the Levels’ Palette,
3 choose the desired adjustment.

To join (not merge) the Adjustment Layer with a specific individual layer:
1 place the Adjustment Layer over the layer to be joined with
2 put your cursor in between the two layers,
3 hold down the alt key, the cursor will change
4 click once.

Layer Masks are masks that are applied to layers and are used to control how much of the layer’s 
information is visible.  On normal layers that means that layer masks control the transparency of the 
layer.  On Adjustment Layers it means that they control the intensity of the adjustment.  Layer Masks 
are normal, full grayscale masks that you can tailor edit to fit any circumstance.  To edit the mask 
you must select it.  To edit the image of the layer, you must select that.  You can use the Brush tool to 
paint white in the mask to expose the information or adjustment, or you can paint black to hide the 
information.  This is used all the time and you need to become very familiar with how to do it.

•	 Layer masks on image layers control the transparency of the image.
•	 Layer masks on Adjustment Layers control the intensity of the adjustment.

Adjustment Layers automatically come with Layer Masks, but layer masks can be added to any 
layer by first targeting the layer and then clicking on the Layer Mask icon  on the bottom of the 
Layers Palette.  
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Adjusting the Tonal Values / Light and dark Values

Let’s say you have a photograph that you have scanned and brought into Photoshop and its overall look 
is too dark.  You may be tempted to use the brightness/contrast adjustment option to correct this, but 
that would not be the best thing to do.  As a matter of fact, you should make it a point to never use 
this option as it is more destructive to your image than it is beneficial.  Instead, you should use and 
Adjustment Layer that offers great control and quality such as Levels or Curves.

The Levels Adjustment layer is accessible from the half moon 
icon on the bottom of the Layers Palette.  When you click 
on an adjustment layer in CS5 and above the Adjustments 
Palette appears with that adjustment’s options ready to be 
modified.  In the case of the Levels, a histogram is displayed.  
A histogram is a chart that represents the image’s tonal values.  
The histogram reads left, being black, to right, being white.  In 
the example to the right, Notice that there is a high peak in 
the white (right) side of the histogram.  This is representative 
of a large amount of lighter area in the image.  Notice though 
that the white areas bottom out before it reaches the very right 
end of the chart.  That means that even though there is a large 
amount of lighter area in the image, it does not quite reach 
pure white.  That is a good thing, because it allows for some 
pigment to be represented in the brighter areas, which help to 
give it some definition. That is, it keeps it from being “washed 
out.”

Notice the three triangles that are immediately under the histogram.  These are slider value points 
that represent specific tonal ranges.  The left black one represent 100% black; the middle gray one 
represents 50% black, and the right white one represents 0% black.

By sliding these value points, you rearrange the tonal values 
of the image.  In our Levels example to the right, the black 
value point has been slid approximately to the 50% mark.  
This is where the 50% gray value point used to be. (It moved 
automatically to remain in the new 50% range).    This 
adjustment reassigned the values of the image and made 
the 50% range become the 100% range; the 25% range 
automatically became the 50% range and the 0% range did 
not move.  After this function is applied, all the tones to the 
left side of the black value point will become solid black.  This 
will have the effect of making the image look darker, similar 
to reducing the exposure when taking a photograph.  (Note: If 
the white point were moved to the left, all the tones to its right 
would become pure white upon applying the effect).
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The example to the right is what the Levels look like after the 
previous Levels example has been applied.  Notice that the 
histogram looks like it has been stretched out.  That is exactly 
what happened.  The previous Levels adjustment cut out all 
the tones that were from 100% pure black up to 50% black and 
relegated them to become one tone, pure black.  That is why on 
this Levels’ example you see a tall solid black line that almost 
looks like it is just the border of the window, on the black side of 
the histogram.  All those tones became the same black value and 
is therefore represented by only one line on the histogram.  The 
other tones have now been reassigned and that is why it looks 
stretched out.

(Note:  You can also move the mid range marker and reassign 
the 50% range while not touching the Blacks or the Whites.  
This is a most useful way to lighten or darken an image without 
changing the light or dark ranges of your image.)

Adjusting the Tonal Values Within a Specific Tonal Range
Another Adjustment Layer option is the Curves. It is more 
sensitive and not as easy to use as the Levels, but it does offer 
some powerful and useful options.  The Curves Dialog Box allows 
you to change the level of the tonal value ranges anywhere along 
the spectrum of the full tonal range of the image.  The Levels only 
allowed for a total of 3 tonal rage points to be controlled.

Pick a spot along the line you want to adjust and then drag it up 
or down to see how it affects the image.  Try defining a myriad 
of ranges by clicking on additional points on the line.  What you 
see will make you think that you just got time warped back to the 
1960s.
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Adjusting the Color Balance of an Image
It is very common to have a photograph that looks a little 
off when it comes to overall color balance.  A general way 
to correct most of these images is with the Color Balance 
Adjustment Layer.

The way to use this function is to drag the corresponding slider 
in the opposite direction of the color that your image needs to 
be rid of.  For example, if your image had a greenish tint to it, 
you would click the slider between Magenta and Green and you 
would drag it to the left towards the magenta, away from the 
Green.  You must also be aware of approximately what range 
you are trying to affect and set the Tone Balance radio buttons 
accordingly.  In other words, if your image’s color is off in the 
highlights, then click on the Highlights radio button and make 
adjustments.  If it is also off in any of the others, then click 
on those as well.  Each one is treated as a separate and specific 
adjustment.

A more precise way to correct color is to directly edit the 
individual color channels using the Curves Adjustment Layer.  
With an understanding of the RGB and CMYK Color Models, 
unwanted color casts can effectively be removed.  This is done 
by identifying the undesirable color cast and reducing that color, 
or by identifying the cast’s opposite color and increasing it.  
Increasing the opposite color has the effect of canceling out the 
unwanted color cast. 

RGB is a visible light color mode based on the primary colors for light, 
Red Green & Blue. When these colors are mixed they form Pure 
White as is illustrated in the chart to the right.  Secondary light colors 
are formed where each color intersects its adjacent neighbor. Green + 
Blue = Cyan, Red + Blue = Magenta, and Red + Green = Yellow.  Each 
secondary color is the exact complement to its opposite color to form 
Pure White.  For example:

Cyan is the opposite color of Red.
Magenta is the opposite color of Green.
Yellow is the opposite color of Blue. 

Equipped with this knowledge anyone can learn the basics for color correcting an image.  All one 
must do is recognize and identify any unwanted color cast.  The best way to identify color casts is 
by using certain elements of the image as a color guide.  One of the most useful elements to use is 
flesh tone.  Our eyes are so used to seeing skin tone within a certain color range that if it is off we 
immediately recognize it as a color cast.  Green skin is OK for a chameleon but not for a human. If we 
see someone with a slightly green skin tone, we are immediately tipped off to the fact that the image 
has a green cast to it and must be corrected.  

Another element that is useful in identifying color casts are things that are commonly known to be 
neutral gray.  This not only applies to middle gray but to dark gray (things that should be black) and 
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light gray (things that should be white).  If we find color in what is suppose to be a neutral gray, such as 
pavement, then we know that there is a color cast.

Once a color cast is recognized and identified as undesirable, it can either be reduced or its complementing 
opposite can be increased to cancel it out.  Deciding which of these two steps to take requires an 
understanding of how visible light works.  We are all familiar with how pigment colors work, they get 
darker when combined with each other.  However, visible light colors works in just the opposite manner, 
they get lighter, or whiter, when combined with each other.  So if you choose to correct a color cast by 
reducing its hue (that is, reducing green light from an image with a green color cast for example), you 
will cause the image to become darker because you are taking light away from the image.  Likewise if you 
choose to correct the cast by increasing the complementing opposite color (adding magenta light to an 
image with a green color cast for example) it will have the effect of lightening up the image because you 
are adding light to the image. The determining factor for which to use will depend on the images overall 
brightness.  If the image needs to be a little darker then subtracting the color of the cast would be the way 
to go, as it would darken the image.  If the image needs to be lighter, then increasing the complementing 
opposite color would be in order, as it would lighten the image.  However, if the brightness of the image is 
within acceptable limits and a color correction is necessary then a combination of the two should be used 
to keep the brightness within acceptable limits.

To edit the individual channels in the Curves 
Adjustment Layer, hold down the Channel drop down 
menu, and select one of the individual channels to edit.

Following are some example scenarios to help you see 
how the basic process of correcting color works.

Example #1 An image that has a greenish cast to it and is slightly dark. 
1. The first step is to refer to the RGB Chart to determine what the opposite color of Green is.  (Can 

you figure it out before I tell you.  Here is a hint; it is not Red).
2. Because the image is slightly dark we choose to use the complementing opposite color to gain the 

benefit of brightening up the image while at the same time canceling out the green color cast.  The 
opposite color of Green is Magenta, therefore the two color channels that make up Magenta, (Red 
channel and Blue channel), are increased, adding Magenta light, which has the effect of canceling 
out the greenish cast and brightening up the overall image.

3. However the image became to bright, as it was only slightly dark and only needed to be slightly 
lightened.  Therefore the Red and Blue channels were reduced just a bit and the Green channel was 
also reduced just a bit to arrive at an appropriate brightness and color correction. 

Example #2 An image that is very light and has a Cyan cast to it.
1. In this case the image needs to be darkened when the adjustment is made.  This being the case the 

complement of Cyan to will not be used to adjust the color as it would cause the image to become 
even lighter.  Instead Cyan will need to be subtracted from the image.

2. Cyan is a combination of Blue and Green as the Chart demonstrates.  So these two channels are 
decreased resulting in the effect of subtracting Cyan from the image, taking away light, causing the 
image to be darker.

Remember, only the unwanted color casts need be removed.  If you like, it keep it.  If you find yourself in 
a situation where you must choose between a cool color cast and a warm one, choose the warm one (more 
yellow) as it is more pleasing to the human eye.

For this class you will do your work in RGB, but the same color correcting procedure can be used in the 
opposite color mode CMYK. 
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Automatically Adjusting Tone & Color / Eyedropper Tools
A very Quick and Powerful way to adjust an image’s tonal range and color 
balance at the same time can be done using the Eye Drop Tools in the Levels 
and Curve Adjustment Layers.  They work on the principal of neutral gray.  
You use them to define the Black Point, the White Point and the Middle 
Gray Point.  This has the effect of adjusting your tonal value as well as your 
color balance.  To use the Black Eye Drop Tool, find and click on it  in the 
Adjustment Palette, and then choose a spot in your image that you feel should 
be black such as a shaded tire or shaded black hair.  To use the White Eye Drop 
Tool, click on it  and use it to choose a spot that you feel should be white 
such as a shirt or a piece of paper.  To use the Middle Gray Eye Drop Tool click 
on it  and choose something that you feel should be middle gray such as 
cement or anything that should have no color, it does not matter how light or 
dark it is.  You can continue to choose different values until you feel that you are 
satisfied with the effect.  When you use the Black and White droppers, you will 
have noticed a very strong change in tones as wells a color.  This makes using 

these two adjustment feature not so useful.  However you can use just the middle gray eyedropper to just 
do a color cast correction and this is very useful and powerful.  It often works better than trying to do a 
manual color cast correction.  You can click around until you find just the right adjustment.

Practice using these tools, but do not come to rely on
then to the point that you forget how to do it manually.

Adjusting The Hue and Saturation
Imagine having the ability to make your tie match your jacket, even 
if it did not at the time the photograph was taken.  With the Hue/
Saturation Adjustment Layer you can do just that.

With this powerful dialog box you can quickly adjust the hue and the 
saturation of an image, or particular part of the image, such as a tie 
by editing the layer mask so it only hits the tie area.  To work with the 
Hue/Saturation Adjustment Layer, simply drag the sliders and pause 
to see the preview of how it will look.  To edit a specific range of color 
hold down the Edit pull down menu, where it says “Master” and drag 
to the desired color range that you want to edit.

When you choose to edit an individual color range, such as red, a color 
range slider bar appears in between the two color bars at the bottom 
of the Adjustment Palette.  The range of the inner slider bar displays 
what color range will be affected 100%.  The range of the outer slider 
bars display how far the effect will gradiate, or transition out.  You can 
further refine the manipulation by dragging in or out these color range 
bars whereby you will enlarge or reduce their reach.
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Filters
Another very common means of manipulating pixels is through the use of filters.  Photoshop comes 
with all kinds of filters.  Additional third party plug-in filters can be added as well.  A word of caution to 
the new Photoshop user: it is easy to get carried away with the filters.  If you’re not careful, the filters will 
simply become cheap tricks that cause your image to look cheap and cheesy.  Filters should be used to 
contribute to your overall image, not to become the main focus of your image.

I will discuss the two most heavily used filters and let you go on your own and discover what the other 
filters do.  You will have a lot of fun doing it.

The Gaussian Blur Filter
The most heavily used filter, from my point of view, is the Gaussian Blur. The 
Gaussian Blur Dialog Box is located under the file menu option Filter > Blur > 
Gaussian Blur.   This filter is used to do just what it says, blur pixel areas.  It can be 
used to soften a harsh area, or blur out the background of a composition to bring out 
the primary foreground object.  If you want to make something glow like an angel, 
you would use this filter to blur a layer of white pixels that are in the shape of the 
object to be highlighted, sandwiched in between the background and the foreground 
object that is to be highlighted.  I am always using this filter to do a similar effect 
with text, to make it stand out from the background.  To use this filter you just move 
the slider to increase or decrease the blur radius according to the look you are trying 
to achieve.

The Unsharp Mask
Another filter that has hidden merit is the Unsharp Mask. The Unsharp Mask 
Dialog Box is located under the file menu Filter > Sharpen > Unsharp Mask.  
This filter is used to sharpen images to your own visual preference.  Blurry images 
can be amazingly brought into focus with this tool.  It is also a good practice to use 
this filter on images that have been resized down, that is, images that have been 
greatly reduced in resolution size to form a much smaller image.  (Images that 
have been reduced in resolution become slightly blurry).

The Amount slider controls the amount of sharpening to be applied.  The Radius 
slider controls how far out the band is going to reach for sharpening.  The 
Threshold slider tells the filter how different the surrounding pixels have to be 
before it allows the filter to be applied to that particular pixel in the radius.  As a 
basic rule of thumb, the Radius and the Thresholds should be kept very small, but 
experimentation is always in order.

Fading Filters Functions
Many times when a filter or adjustment is applied it may look too intense.  
One of two things can be done to fix this.  1) you can simply undo the filter 
step and then do it again with a less intense setting, or 2) you can undo the 
filter step and then invoke the Fade Command (  +  + F), which 
allows you to fade the post filtered image into the pre filtered image to 
form an aesthetically pleasing mixture of the two.  
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Cloning
A very powerful feature afforded to us by digital imaging is known as Cloning.  A later 
section will be devoted to the various techniques used to master the art of cloning and digital 
restoration, but I feel it necessary to now introduce you to the Clone Stamp Tool.

This tool allows you to paint with given natural texture rather than flat color.  With this tool 
spots and scratches are seamlessly removed from images.  Facial blemishes and wrinkles 
are removed from faces. Beer cans and telephone poles are removed from vacation photos.  
“Authentic” UFO images are created.  Unwanted people are removed from Photographs 
without the use of scissors.  Images are built and extended where they were not properly 
photographed.  This is a very powerful and fun tool to use.

To use the Clone Stamp Tool first be sure that you have actually chosen the correct Stamp Tool as there is 
another tool that resides on the same place on the Tool bar called the Pattern Stamp Tool.  After you are 
sure that you are in the Clone Stamp Tool, position your mouse pointer over the area that you want to use 
as the texture source.  You then hold the  key down and click the mouse to define an anchor point.  
Now move the mouse pointer to where you want to reproduce the texture and click.  As soon as you 
click to start cloning the distance and directional relationship between the anchor point and the initial 
insertion point is set and will not change until a new anchor and a new insertion distance is defined.  Note 
that the anchor point moves along with the insertion point.  It is not the exact position that you first chose 
but is a relative distance that remains a constant throughout the use of the tool.  The anchor can, however, 
be made to be a fixed point on the canvas by adjusting the settings in Options Bar.

Practice using this tool to remove spots and scratches.  To do this, adjust the size of the brush to be about 
the same size as the spots and dust marks.  Next locate a spot free area, preferably one very near the spot 
to be fixed, which has a very similar texture and color.  Anchor that clean texture area by holding the 

 key down and clicking once.  Now move the mouse over the dust spot and click once.  If the spot is 
not gone repeat the process until it is.  Play with this tool until you fully understand how it behaves.  Note 
also that the Options Bar offers additional functions for this tool.

The Spot Healing Brush
The healing brush is a kind of sophisticated Clone Tool.  To use this tool, make your brush slightly 
bigger than the spots that you are going to be working with.  Then you simply blot out the spots by 

clicking on them.  The tool works by automatically finding texture in the image that is similar, and then it 
performs a filter effect on the texture before it applies it.  The texture is given the color of the target area 
and its edges are softened so that it blends in seamlessly.
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Correcting Light and Dark Blemishes with the 
Burn and Dodge Tools

The Clone Tool is great for laying down new texture over scratches, 
spots and imperfections, but when it comes to light and dark blemishes, 
the Burn and Dodge tools are the ones to use.  If the blemish is a light 
spot, the Burn Tool would be used in conjunction with the appropriate 
brush to darken the pixels to match the surrounding area.  If the blemish 
is a dark spot, the Dodge Tool would be used in conjunction with the 
appropriate brush to lighten the pixels to match the surrounding area.  
These tools have an exposure setting displayed in the Options Bar.  The 
exposure setting controls the percentage of application of the tool (how 
much the tool affects the pixels).  These tools work best if the exposure is 
set to a low percentage, somewhere between 7% – 20%.  This allows you 

to brush over the blemish over and over again until the pixels match the area around them.  Specific tonal 
ranges that are to be affected are also specified in the Options Bar.  It is usually best to have the Dodge 
Range set on Shadows, so that the Dodge Tool will lighten the darker pixels faster, while not affecting 
pixels that are already light and don’t need to be made lighter.  In the same way it is usually better to have 
the Burn Range set on Highlights so that the Burn Tool will darken the light pixels faster, while not 
affecting pixels that are already dark and don’t need to be made darker.

Text
Photoshop has develop a very powerful Type Tool  
considering the fact that this program is pixel based.

To use the Type Tool simply click about where you want 
your text to be and type directly on the image.  The Type 
Tool automatically creates a new layer to hold the text 
information.  To edit existing text, double click on the white 
box with the “T” located in the layer containing the text 
information.  Another way to edit the text is to click it with 
the text tool and it will go into an edit mode.  More editing 
options are available in the Options Bar.
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Layer Styles
Photoshop has made it easy to give flat shapes cool 3D effects, 
which are user defined using Layer Styles.  Using Layer Styles is 
a great way to make text stand out and look much more appealing.  
Experiment with this feature using these next two exercises.  You 
may want to save the “cool things” that you create.

Select the Type Tool  and type your name.  Make the text a decent size.  After typing, make sure 
that the text layer that you just made is the targeted layer.  Then go Layer > Layer Style > Bevel and 
Emboss or just Double Click on the layers “name.”  Now play with the settings and watch your text as 
you make your adjustments.  After you have arrived at something you like, move to a different effect.  To 
do this, click and target one of the effects listed on the left side of the Layer Styles window.

Now let’s do some effects on some flat shapes.  First 
make a new layer.  To do this, click on this  icon 
located on the bottom of the Layers Palette next 
to the Palette’s trash can icon .  This will create a 
new layer.  Now take your Lasso Tool  and define 
a shape.  Fill the shape with pixels by going to the 
File menu Edit > Fill or (   +   ). Choose 
a means of filling it and then click OK.  Next, make 
sure that the new layer is targeted and follow the 
previously described steps to apply a Layer Style.

To edit an existing layer’s Style, simply
double click on the “f ” to the layer’s name.

Recap
You have learned that Photoshop is all about the selection and manipulation of pixels.  You have also 
learned how to make selections and how to manipulate those pixels that are selected.  Hopefully you 
have begun to put 2 and 2 together and understand how to practically make use of these principals.

Let’s say that you have an image, a photograph of you and your family that was taken in bright 
sunlight in Mexico City.  You notice that because you wore your sombrero (big hat) your face is in 
dark shadow whereas everyone else’s faces are nice and bright.  Being the Photoshop Pro that you are, 
you immediately know what you need to do to fix the problem.  You decide that you need to define a 
selection of the area where your face is, but you don’t want the selection to be too sharp and abrupt, so 
you decide to use a Curves Adjustment layer and you adjust it so that the face look good, but this made 
the rest of the image too light.  So invert the Adjustment Layer so that it becomes solid black, completely 
hiding the effect from view.  Next you take a brush with a 70% hardness and white for the foreground 
color and paint the mask on the face area so that the Adjustment layer affect the face area, making only 
the face lighter, and not the whole image.  After fixing the shadow area, you go ahead and remove the 
salsa stain that is on your son’s shirt using the Clone Stamp Tool.  And so you go until the image is 
touched up to your liking…
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VIII. Image Restoration
In Photoshop, restoring old photographs or fixing up current ones can be a challenge and a joy at the same 
time.  Taking things one step farther, we will now add to your basic knowledge of Photoshop some advanced 
techniques that you can use to restore and repair images.

Advanced Clone Stamping Techniques  
Take time now to review the previous section dealing with the Clone Stamp Tool to re-familiarize 
yourself with the basic functions of the Clone Tool.

In the previous section you learned how to remove spots and dust marks from your images using the Clone 
Tool.  The same principle of using similar image areas to remove spots can also be used to remove whole objects 
from your image.   Look at the example to the right as we follow the progression of how 
the rifle was removed.

1. The first step was to determine the right size brush to use.  In this case it was just 
a bit wider than the width of the barrel.  The next step was to determine a good 
place to start.  In this case it was an area in between the two people standing up, 
just above the rifle barrel.  The first location was chosen because the dress’ angle 
and the green shrubs just to the right of the dress were about the same as what 
the rifle area would be if there were no rifle.  The anchor for the source was set by 
holding the  key down and clicking the mouse once over the desired area.

2. Next, the brush was set over the exact area that the anchor was prepared for.  The 
mouse was clicked once to see if the cloning was a smooth match.  Most of the 
time the first cloning test is not a smooth match and therefore has to be undone 
by the Quick Key (  + Z ).  Positioning the Clone Tool was repeated until it 
proved to be a smooth match.

3. Once the match was made, the Clone Tool was carefully dragged along the line of 
the barrel until the source area (designated by the cross hair “+”) was about to be 
inconsistent with the area of the barrel.  A new anchor point was defined and the 
whole process was repeated.

4. It probably took about a good 20 to 30 different clone settings as well as about 10 
different brush size changes to complete the removal of the rifle.

The Clone Stamping Tool is not only used for removing objects but for completing or 
adding on to existing objects.  For instance, let’s say that a door got cropped off at the 
bottom when it was photographed and you need the whole door in your image.  The first step would be to 
choose the right size brush.  Next, you would make special use of the lines that the door edges make.  Those 
lines are your guides for placing your anchor and your insertion point.  The anchor would be placed exactly 
on the line of the edge of the door the distance of a full 2 to 4 brush sizes above where you intend to start 
laying down the cloned image.  You would then position the insertion point exactly where that line ends at 
the very bottom of the existing door.  After testing, to see if it is a smooth match, you drag the mouse down 
slowly moving it in quick little circles as you come down so that you do not miss any spots.  Let the mouse go 
every few little strokes to let the cloned image take so that you do not accidentally clone the empty space.  (The 
cloning does not actually become part of the image until you let go of the mouse.  Because of this, even though 
you see what you have been laying down, it cannot be picked 
up by the Clone Tool and re-cloned until it becomes part of 
the image.  That is why you should let the mouse go every 
few little strokes to let the cloned image take so that you do 
not accidentally clone the empty space.)

Notice how the lines of the board wall are used as a 
guide for the Clone Tool to remove the vine from the wall.
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Patching Techniques
Another way to build and correct images is by use of patches.   A patch is usually a small area that was 
copied from the main image and then pasted into its own layer above the main image.  The patch is then 
positioned over an area that it is to cover and is tailored for a seamless fit.  Tailoring the patch usually 
involves using a layer mask with a fuzzy brush, black foreground color, to soften the edges of the patch so 
that it blends well with the background image.  Sometimes the patch needs to be edited using the Free 
Transform Function (   + T ), which allows for the enlarging, stretching, skewing and rotating of 
the patch.  Tailoring the patch can also involve the use Adjustment Layers or Filters that were discussed 
in previous sections such as Levels, Curves, Color Balance, Hue Saturation, Gaussian Blur, UnSharp 
Mask, the Clone Tool or any other manipulation.  Once the patch has been tailored to form a seamless 
match with the main image it is merged with the main image.  It is a good practice to duplicate the patch 
layer before it is merged so that all the work that it took to make the patch will not be lost, just in case 
application of the patch is needed elsewhere or in the future.  (Imaging Tip:  If your subject’s eyes are 
beyond noticeable repair, you can always borrow a pair of eyes from another source)

Free Transform Function
Open up one of your images and target the practice layer.  Now make a selection of something, a pocket, a 
head, a hand, a bush, anything.  After you define your selection do a Copy (  + C ), and then a Paste 
(  + V).  Anytime a copied selection area is pasted, Photoshop automatically creates a new layer 
for that which it pastes.  Use the Move Tool  to move the layer that you pasted away from the area in 
which it was pasted. Now invoke the Free Transform Function (  + T ).  When you invoke the Free 
Transform Function, a transform box appears around the outer edges of the pixel 
image.  A handle node appears at every corner and at the middle of every side of the 
transform box, a total of eight handle nodes.

1. To Move the whole object click on the inside of the box, but not on the 
center point, and drag to the new location.

2. To Rotate the object move the mouse outside of the box to get the rotation 
icon on the mouse pointer and click and drag in the circular direction that 
you want it to rotate.

3. To Stretch or Squish the object, click and drag a corner node in or out, up 
or down, and it will stretch or squish the image accordingly.  Dragging one of the side nodes in or 
out would have the same effect.

4. To Proportionally Enlarge or Reduce the image, hold down the  key while a corner node 
is adjusted.  It will constrain the proportions and only allow the image to be enlarged or reduced, 
without being stretched or squished.

5. To adjust the Perspective of the image, hold down the  Key while moving a corner node.  
Now the other corner points do not move but only the one being dragged by the mouse, thus 
creating a perspective change.

6. To Skew the image, hold down the  Key and drag one of the side nodes.  This causes the 
whole side to move as a unit thereby skewing the image.

To add additional functionality to these procedures include the  Key to offer constraining, and the 
 Key for the object to be transformed relative to its center point instead of its location. Practice 

using the Free Transform Function until you are familiar with how it works. 

Patch Tool is a powerful way to do simple patchwork. The Patch Tool is a little like a Lasso Tool 
and a Spot Healing Brush Tool, in one.  It works by selecting the area that you want to patch over 

and then you put the selection to a textured area somewhere else and then let go.  Photoshop grabs the 
area where the selection was moved performs a filter on it to adjust its color and tone to match the 
original area defined and then mergers it in.  It is actually quite useful but only for the things that it can 
handle.  What it can not do the Clone Tool or the Spot Healing brush would have to do.  Practice it. 
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Advanced Selections
You have already learned how to create selections using the Selection Tools.  Selections can also 
be attained in many other ways as well.  Layers, Channels and Paths can be used as a means of 
deriving selections.  To activate a selection that is based off of a Layer, or a Channel, or a Path, hold 
down the  Key and click on the source Layer, Channel or Path.

Layer Selections are derived from the solidness of the pixels on the layer.  That means that if the 
whole layer is completely full of pixels that are 100% solid, you would get a rectangular selection just 
as if you did a Select All (  + A).  On the other hand, if you used a layer such as a Patch Layer, 
discussed in the last section, your selection would be the exact representation of the solidness of the 
patch.  You would then have a selection with which you could extract the exact shape of the patch 
from another layer of pixels.  I hope that you see the potential of this feature.

Whereas Layer Selections are derived from the solidness of the pixels on a given layer, Channel 
Selections are derived from the tonal value of the image that is currently visible.  Channels produce 
selections that are the equivalent of grayscale photographs which are great for smoothly adjusting the 
images that they were derived from.  This type of selection can also be used to create special effects 
when the selection is used on a different image than the one from which it was derived.

Path Selections are simply the outlines of a path being converted to a selection.

Advanced Tonal Correction
Many images needing restoration require a more precise and specific 
adjustment than a normal Levels adjustment to attain good contrast.  One 
technique used to accomplish this feat involves the use of tonal selections.  
To attain a tonal selection hold down the  Key and click on the RGB 
channel, (You could just as well have clicked on any channel and it would have 
loaded a selection based off of that particular channel’s tonal value).  The 
Marching Ants are now following the contours of your image.  This is because 

the selection is actually a black and white 
version of your image.  You will be editing your image through 
a mask (a selection) that is the exact tonal value of your image.  
With this tonal selection you can perform adjustments specifically 
on the overall light area, without really messing with the dark area, 
and vice versa.

After attaining a tonal selection, adjustments may be applied to 
your image just like normal.  Before applying your adjustments, 
first make sure that the selection is on the particular area of the 
image that you want to edit.  You may need to perform an Inverse 
command (   +  + I) to correctly set the selection on the 
intended pixel area.

Tonal
Selection

Inverse of Tonal 
Selection
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Large Area Cleaning
By now you have discovered how tedious it can be to cleanup even a small area (such as a face) of a very dirty, blotchy, 
coarse image using the Clone Stamp Tool and various other techniques.  It is necessary to give that much attention to 
an area such as a face, which mandates detail and clarity, especially the eyes. However, for large areas that are of lesser 
importance, such as meaningless backgrounds, it is usually not worth it.  

Instead there is a more practical way to deal with these relatively large and meaningless pixel areas.  It involves
1. Duplicating the layer.
2. Cloning the background into and over 

the outer edges of the object that you 
want to keep.

3. Locking the layer’s transparency, which 
is next to the lock all Icon.

4. Applying a very strong Gaussian Blur 
filter to it, wiping out detail.

5. Applying a strong Noise filter to restore 
granulated texture to start to match the 
feel of the original images grainyness.  
The Blurring and adding of Noise is 
repeated two or three more times at 
much lesser degrees of strength to attain 
a background texture that is acceptable 
to the human eye, making the cleaned 
area look as if it were of similar grain as 
the rest of the image.

6. Applying a mask to the image just 
manipulated and inverting it so that it is 
all hidden.  All that is showing at this point is the image that was copied from with no change.

7. Painting white on the mask, revealing the worked smooth background, keeping the original object.

Practice this technique on one of your images that has large meaningless backgrounds until you get the hang of it.

Small Area Cleaning / Dust & Scratches Filter
Another very useful tool is the Dust & Scratches Filter.  It works best in removing these visual blemishes when applied 
to areas that have similar tone and texture.  This filter can be used to take care of those lesser important areas that 
require cleaning much faster, and sometimes with better results, than using the Clone Tool.

First, define a selection of the area that you want to treat for dust and scratches.  
Next Go: Filter > Noise > Dust & Scratches.  In the Palette that appears, drag 
both sliders to the very left.  Next, move the Radius slider to the right until just 
after the dust and scratches in the image become blurred out.  Next, move the 
Threshold slider to the right just until the dust and scratches become visible again, 
and then drag it back to the left just a few notches until the dust and scratches 
disappear again.  Toggle the Preview off and on to see the before and after.  Adjust 
the settings to recapture the original grain yet without the dust or scratches. 

Practice this technique a few times on different areas of your image.
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Final Image Preparations / Color Modes and Styles
After you have completely restored or touched up an image, the next step is to consider what color mode 
might best represent the mood or motif of your image.  Would the image look best presented in its 
original color, or might it look better in black and white?  Perhaps it would look best if it were made to be 
a duotone image having a sepia, or color tint to it.  If your image is a Black/White Photograph you might 
try painting it so as to make it look like it were actually a color photograph.  Another option would be to 
make a single item in the image to be color while making the rest of the image to be black and white.

Adding Color to your B&W image.
If you choose to, there are several ways that you can add color to a Black & White image.

The quickest way to add color to a B&W image would be to:
1. Make sure that you are in RGB Color Mode.
2. Make sure that your final image layer is targeted.
3. Open up the Hue Saturation Dialogue Box and click on the Colorize check box.
4. Adjust the Hue, Saturation, and Lightness settings to your personal preference, click OK.

A better way to add color to an image would be to:
1. Make sure that you are in RGB Color Mode.
2. Go to the Layers Palette and insert a Color or Gradient Fill layer using this  Icon.
3. Make sure that the Fill Layer is above the layer(s) that you want to colorize.
4. Experiment changing the Fill Layer’s Blending Mode and Opacity settings until you arrive at 

something that you like.

To paint a B&W image:
1. Make sure that you are in RGB Color Mode.
2. Create a new blank layer for each color or object that you paint over.
3. Adjust the Blending Mode and Opacity settings for each layer that you create. Don’t leave the 

Blending Mode on Normal, you don’t want it to look like you painted it.
 (This painting process can be very rewarding and very frustrating).

A powerful way to colorize a B&W image is to use the Duotone Mode:
1. Make sure that your Original layer is turned off.
2. Save a copy of your file as a TIFF including the word “Duotone” in the new file name.
3. Open the file that you just saved and then make sure that it is in Grayscale Mode.
4. Next, put the file into Duotone Mode: Image > Mode > Duotone.
5. Choose two or more colors and Experiment adjusting each color’s curves, until you arrive as 

something that you like, and then click OK.
6. Select all (  + A) and copy (  + C)

and then save (  + S) and close (  + W) the file.
7. Make sure that you are in your Master file that you started with and

make sure that it is in RGB Mode.
8. Paste (  + V) the colorized image into the Master file, and place it under the Original 

Layer.
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Does it need a border?
Another presentation element to consider is whether or not you want a border around your image.  
Would your image look best plain, with no border, or would a border be a pleasing complement to 
your image.  How thick should the border be, and what shape would best compliment your image: oval, 
rectangle, rectangle with rounded edges, etc…?  Should the border be a solid color or should it be a 
texture or a pattern? (Don’t get to carried away).  There is no border button, so if you want a nice border, 
you will have to construct it using the techniques that you have already learned.

If you have read through the previous sections with-
out working through them, then you must go back 
and work through all of them!  This course does not 
work through osmosis, but by practice.

If you have thoroughly worked through this book up 
until this point and have gained a firm grasp of the 
concepts presented and the skills required then you 
may consider yourself done with Stages 1 - 5 of the 
Course Guide.

Refer to the Course Guide and carefully read Stage 6. 
Restoring and Touching Up Your Images 
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IX. Color Modes
A Color Mode is a state in which a graphic file exists.  Color Mode 
has to do with what color model is being used to make up the file.  
Several Color Modes exist for various situations, as follows:

Bitmap mode has only two colors, black and white.  This mode is 
good to use with high resolution (600dpi) scans of text or line art.  
Because there are only two colors, file size is very minimal.

Grayscale mode is used for full tone black and white photographs.  
It is a good mode to use for your black and white images because 
it consists of only one channel, which is typically 1/3 the file size of 
an RBG image which has three color channels, and 1/4 the file size 
of a CMYK image, which has four color channels.

Duotone mode can be used to give a grayscale image a sepia, aged or color tinted look.  This mode 
actually has four possible states including Monotone, Duotone, Tritone and Quadtone. This mode 
allows you to choose exactly which color each channel is to represent.  It also allows you to control 
the curves of each channel.  To use this mode you must first convert your image to grayscale then 
you will be able to convert it to Duotone.  To edit the Duotone information after your image has been 
converted to Duotone, simply go back to Image > Mode > Duotone and you will be able to tweak the 
values as you desire. 

Indexed Color Mode can have up to 256 colors that you define for its color Palette.  This Mode is 
used as a means of saving color images with smaller file sizes than a full blown RGB file.  It is also the 
mode that is used by one of only two traditional pixel graphic file formats for the web, that format 
being “GIF.”  I prefer to pronounce this file format the way that it is spelled “gif,” and not “jiff ” which 
is a brand of peanut butter.

RGB Color mode is used for full color images, especially those that are destined for video or for the 
web when saved in the “JPEG” file format.  This is also the mode that you will primarily be working 
in while using Photoshop.  It is made up of the Light Color Model of Red, Green, and Blue.

CMYK Color mode is used for full color images, specifically those that are destined for print.  This 
mode is made up of the Ink Color Model of Cyan, Magenta, Yellow, and Black.  It is a good idea to 
work primarily in the RGB mode and then convert it over to CMYK when you have completed your 
work.  The reasons for doing this are two fold.   #1. RGB has a smaller file size as it uses three channels 
instead of four.  This becomes especially helpful when multiple layers are being used to construct an 
image, which causes massive file sizes. #2. CMYK mode is restricted from various filter applications 
that you may want use on your image.

Lab Color and Multichannel Modes are beyond the scope of this class.
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X. File Formats
The following is a list of the primary file formats that you need to be aware of for proper file 
preparation, storage and image destination.

PSD –{Photoshop Document} –This is Photoshop’s own file format.  In order to preserve Photoshop 
information such as Layers, Channels, Paths and other information unique to Photoshop, it is 
necessary to use the PSD format.  Master working files that have Layers or other information that 
need to be preserved for future editing, should be saved in PSD.  Master working files that do not have 
Layers should be saved as TIF to reduce file size.

TIF – {Tagged-Image File Format} – TIFF uses a lossless compression scheme.  This means that an 
image saved in TIFF format will not lose any image quality even though it is being compressed.  TIFFs 
can also be saved with LZW (Lemple-Zif-Welch) compression, which is also a lossless compression 
scheme that can reduce the files size even more.  LZW compression is most effective for images that 
contain large areas of similar color.

The old TIFF format did not support Photoshop Layers, but it did support Channels and Paths, which 
made it great for saving master working files that have no need of layer preservation.  The new version 
of TIFF does support layers, but if layers are necessary, why save it as a TIFF when you can save it as a 
Photoshop Document.  I am still not 100% sure about this.  One very important thing about TIFF is 
that it is the standard format for preparing images for professional printing using publishing programs 
such as Quark and InDesign.

EPS – {Encapsulated PostScript} – This is the format that both Vector Graphics and Pixel Graphics 
and even Page Layouts are saved in for the purpose of being placed in another program, or to go to 
a RIP (Rasterizing Image Processor) Server and printed on a PostScript Printer.  PostScript can be 
thought of as being cooking instructions that are included with the file.  The file can be thought of 
as being the ingredients.  The RIP can be thought of as being the cook who prepares the ingredients 
according to the directions given in the PostScript. The Printer can be thought of as the oven where 
it all gets cooked.  Photoshop images are already rasterized in that they are already divided up into 
a grid of pixels.  It is therefore not usually necessary to save a Photoshop image as an EPS; however 
if it is saved as an EPS, the graphic is given its own printing instructions and therefore can not be 
manipulated by page layout programs in which it may be place, such as Quark or PageMaker.

GIF – {Graphics Interchange Format} – This file format is primarily used for preparing images for 
the Web.  It uses an Indexed Color Palette ranging from 1 to 256 colors, which is user defined.  This 
means that you can choose up to 256 colors from the millions of possible colors to define the color 
Palette used by that particular file.  Another feature that this file format offers is a transparency color.  
One color may be specified as being transparent.  This allows for the background of a web page to show 
through the image which is a great design advantage for making interesting web graphics.  The only 
negative thing about this transparency option is that often times a transparent GIF will appear to have 
a jagged edge.  This is due to the fact that the transparency is not smooth and gradual, but immediate 
and abrupt.  GIFs can also be animated, having more than one frame.  These are known as Animated 
GIFs. 
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PNG – {Portable Network Graphics} – PNG was developed as an alternative to GIF as a royalty free file 
format for use on the Web.  It offers some very attractive features:

1. It is a full color file format, millions of colors, 24-bit.
2. It is a lossless compression scheme where as JPG, the only other full color file 

format capable of use on the Web, is a lossy compression scheme.
3. It has smooth, non-jaggy, transparence capability.

Nowadays the PNG has wide support by browsers and applications.

JPG – {Joint Photographic Experts Group – JPEG} – This file format has a lossy compression scheme.  
This means that when the image is saved, it compresses the file size by throwing out information, thereby 
degrading the image.  The greater the compression (down to 1) the greater is the file degradation.  The 
lower the compression (up to 12) the lower is the file degradation.  The fact that JPEG uses a lossy 
compression scheme should not deter you from using it.  Just use it wisely.  This file format does a great 
job at reducing the file size of images, and if you do it right, the image quality will be indistinguishable to 
the normal viewer.  JPEG is also the primary means of putting a full color image on the Web.  The smart 
way to use this format is as a display copy of an image whose master file is a TIFF, or even a PSD.  In other 
words, you should always have a master copy of your image as a TIFF or PSD and then make a copy for 
display purposes as a JPEG.  A 65MB PSD file with multiple layers can have a copy saved as a JPEG and 
get the file size down to 250k.  That is a size ratio difference of 260 to 1.

PDF – {Portable Document Format} – This is an Adobe file format based on the PostScript model.  It 
is intended to make possible both cross-program and cross-platform sharing of files.  It is suppose to 
accurately preserve fonts, page layout, vector graphics and pixel graphics.  Functionality is also supposed 
to be supported, such as links.  Adobe is putting great emphasis on the PDF file format, so it is something 
that you should be aware of.
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XI. Output

– Not Required for this Course –

Image Size
The first step to printing in Photoshop is getting the printable area of the image to be the proper size.  This 
is done using the Image Size Dialogue Box.  Currently your images should be around 8 x 10 at about 
300ppi.  In the Image Size Dialogue (Image > Image Size) make sure that the Resample Image check 
box is NOT checked.  In the Document Size set the longer side to be 10 inches.  If it causes the shorter 
side to go beyond the 8 inches you will have to set the shorter side to 8 and let the longer side be less than 
10 inches. (If you cropped your image correctly at the beginning of the editing process, then the image 
size should already be perfectly set.  It is so important to do this procedure at the onset of a project 
taking into account the exact output and it’s requirements.  However not every image can be cropped 
to be exactly 8x10 and be aesthetically pleasing.) Note: Your image should not be in CMYK for ink jet 
printing.

Page Setup
The next step is to make sure that your page orientation corresponds to the dimensions of your image.  
Go: File > Page Setup.  If your image is wider than taller, choose landscape or vice versa and click OK.  
The next step is to save your image with these new settings. (  + S)
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Print
To get the Print Dialogue Box, go: File > Print with 
preview.  To the right is the first window that should pop 
up.  Make sure that all the settings in the print window 
match those that are shown here.

Make sure that the Print Space’s Profile is set to 
Working RGB - sRGB IEC61966-2.1

Once all the settings are as shown here, hit the Print 
button.  The file will not print yet, another window will 
appear.

In this next window hold down the third pull-down 
menu (it may have the words “Copies & Pages” 
currently selected) and choose Print Settings:

The Print Settings window appears as shown.

Set the Media Type to: Premium Glossy Photo Paper.  
Set the Mode to: Automatic.
Slide the Quality Slider to the High Quality on the left 
side.

Color printing is a tricky business and things do 
not always work as they should.  Use these settings 
(including the above Color Space Profile) as an initial 
starting point for your printing.  You may wish to 
experiment to see if a different combination might give 
you a better print, but these settings are hard to beat.

After you have all the settings properly set and your Epson Glossy Photo Paper is loaded into the printer 
with the glossy side up, hit the Print button.

Be warned, you may want to do some test prints of a small section of your image and then use them as 
a guide as to what color corrections need to be made before you waste your good paper and the school’s 
costly ink.
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XII. Preparing Images for Publication
(The publication templates that you will be using are located in the class folder.  Please refer to the Course 
Guide for more information.)

Preparing images for placement into publication programs is a relatively simple process.  It involves cropping 
and resizing the image to the required dimensions, possibly sharpening up the image a little to compensate 
for the blur that occurs when an image is resized down, converting it to the CMYK Color Mode, and saving 
it as a TIFF with a new name so as not to overwrite the master file from which it came.  Sometimes a clipping 
path is designated for the image for the purpose of hiding part of it with respect to the shape of the path.  
However, clipping paths are beyond the scope of this class.  If you are interested in how to apply a clipping 
path you can go to the help menu and look up “clipping paths.”

Cropping
Most publication programs have the capacity to crop images that are placed inside of them.  Therefore it is not 
always necessary to crop your image.  However a few reasons why you might crop an image for placement in a 
publication program are, 1) to keep the memory size of the file within working parameters, 2) the publication 
program is without a crop feature, 3) to simply make the file easier to work with once in the publication 
program.

Resizing
The reason that we need to resize images, large images 
especially, is not just to make its physical dimensions smaller, 
but to make the file’s memory size no larger than it needs to be.

Because your images are very large in nature, you will be using 
the Image Size Dialogue Box to reduce the images’ length and 
width, while maintaining a constant 300 or so Resolution.  
Both the “Constrain Proportions” and “Resample Image” 
check boxes should be checked.  (What is actually going on 
is the resolution is being reduced by a great degree and then 
the width and the height are being reduced which causes the 
resolution (that is the pixels per inch) to increase again to the 
number that it was at first).

Sharpening
The more an image is resized down the more blurry it will become.  It is therefore necessary to sharpen the 
image back to an aesthetically pleasing state using the Unsharp Mask Filter.

Color Mode Conversion to CMYK
Cyan, Magenta, Yellow, and BlacK are the primary ink colors used for printing.  It is therefore necessary to 
convert your images to the CMYK color mode. Image > Mode > CMYK Color.

Give it a New Name
Be careful not to overwrite the large master file with this smaller image.  Give it a new name that will clearly 
distinguish it from your restored master file.

Saving it as TIFF
In the Save As Dialogue Box be sure that you change the Format of the file to be TIFF.  This includes 
choosing TIFF from the Format pull down menu and making sure that the file ends with “YourFileName.tif.”
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 EPS Vector Graphics, TIFF Pixel 
Graphics, and text from word processors are 
placed into InDesign where they are arranged 
to produce a pleasant, aesthetic publication.
 Today you will be placing three TIFF 
images into this document.  The locations 
for where these three images are to be placed 
have been numbered for you.  The first two 
images are going to be placed inside preexisting 
Graphic Frames.  The third image will be 
placed in an area where there is no preexisting 
Graphic Frame.
 Three images are required for these 
template assignments.  You may have only 
worked on two image projects and may need to 
acquire a third image just for these publication 
assignments.  You are to use your own images 
and prepare them in Photoshop to meet the 
required size specification.  Your images should 
also have a resolution of 300ppi.

 Image #1 is to be a little larger than 
its oval border, which is 3.3” wide and 4.4” 
high.  Making the image a little bit bigger than 
the frame’s dimensions is acceptable because 
anything that does not fit within the frame will 
be nicely cropped off.
 Image #2 should be at, or slightly above, 
the rectangle’s dimensions of 3” wide, and 4” 
high. 
 Image #3 may be whatever size you 
like, only make it look aesthetically pleasing 
to the eye, and place it so as to complement the 
overall layout.
 Before you begin placing your images, 
save this InDesign file into the same folder 
that your images are in.  It is very important 
to save your InDesign publication file and the 
associated graphic files in the same folder.  
If they get separated you will not be able to 
properly print them.

 Adobe InDesign is a powerful, 
user-friendly publication program 
used by both desktop publishers and 
professional layout 
designers to produce 
professional level  
production work. InDesignInDesign
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 Once your images 
have been prepared in 
Photoshop, and have 
been saved as TIFFs, they 
can be placed into the 
publication program.  To 
place an image into a 
frame, first select the filed 
black Arrow Tool    
from the Tool bar and then 
select the frame that the 
image is to go in. Next, 
go to the file menu option 
File > Place, a window 
will appear in which you 
can navigate and locate 
the image to be placed.  
 After you find your image, double click 
on it.  InDesign will link that image file to the 
frame and put a low resolution, placeholder 
version of the image in the frame.  As a default, 
InDesign does not embed graphic files into 
the publication program.  This is to keep the 
file size of the publication relatively small and 
manageable.  This method of file management 
requires that all placed graphic files be included 
in the same folder as the publication file in 
order to print properly.  If the graphic file is not 
present in the folder then the low resolution, 
placeholder will print instead of the high 
resolution version of the image.
  To adjust the position of the image 
within a frame use the Open Arrow 

 Tool located just right of the 
Filled Arrow, in the Tool Bar. More 
adjustment options are under File 
menu Object. 
 To place an image without a 
preexisting frame, such as for #3, 
simply do the File > Place command 
and locate your file.  Unlike the 
previous times when your image 
automatically appeared in a frame 
that had been selected, this time 
your mouse pointer will change and 
become a corner point.  To complete 
the placement of your image, you 
simply position the mouse over the 

upper left area of where 
you want the image to 
be and then click once 
being careful not to hold 
the mouse down and 
accidentally perform a 
click and drag.  At this 
point you may use the 
black Arrow Tool  to 
select the image and move 
it around, (be careful not 
to select the center circle 
that appears.  If you man 
a mistake just undo and 
then do it again).  You 
should also apply a Text 
Wrap on the frame so that 

it will not cover up any text.  To do this open 
the Text Wrap Pallet by using the file menu: 
Window > Text Wrap.
 Images can be scaled up or down in 
publication programs but it would be better to 
go back and use Photoshop to resize images.  
Resizing images in publication programs may 
result in the image resolution being less than 
acceptable, especially if you scale up.
 Be sure and Delete the #3 first before 
you place the image over it.  When you place 
the third image and apply the text wrap to it, 
this text should wrap around it.  It OK if the 
text spills over to the text box area on the next 
page.



 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 

 
Even though Microsoft Word is a very 

popular word processor, it is just that, a word 
processor.  This program was not intended to 
be a page layout program.  In fact, trying to 
use it as one can be a very exasperating 
experience, trust me, I know.  However,    
MS Word does have advanced capabilities to 
enable you to import graphic images into 
your files, which is a great way to spice up 
your documents. 

Vector objects saved as EPS, and 
pixel images of all sorts can be placed into 
Word.  Unlike InDesign, images that are 
placed into Word are automatically 
embedded into the file.  This causes the 
document’s file size to increase.  Images 
intended for placement into Microsoft Word 
should be kept small because it is not a 

professional level publication program and 
therefore has a hard time dealing with large 
image files.  InDesign, on the other hand, is a 
professional publication program intended 
for use in high quality output situations that 
require images to have high resolutions.  The 
most common output devices for Word are 
laser printers at the office, and inkjet printers 
at home.  A suitable maximum resolution for 
images prepared for MS Word would be 
about 150ppi. 

For this exorcise you will use the 
small images that you prepared for InDesign 
and modify them for MSWord. 
1. First you need to convert them back to 

RGB, from CMYK (if they are grayscale 
you do not need to change them). 

Microsoft 
Word 

Microsoft 
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IMages
 

  Placing   Placing 

in 

Microsoft Word is a widely 
used word processing program.  It 
has developed into a very useful 
tool for producing documents to 
meet most every office or personal 
need. 



2. Next you need to 
your images

resize 

larger than 150ppi 
 to be no 

(resample check box, 
checked). 

3. Lastly you need to save 
them as JPGs for 
word to accept them.  

Unlike the 
previous placement 
assignments, you will 
recognize that there are 
no oval or rectangle 
frames in which to 
place your images.  
Word does not seem to 
support frames.  As such, all three of your 
images are to be placed independent of any 
frame. 

Even though Word embeds image 
files that are placed into it, in general, it is 
strongly recommended that you keep the 
original image files in the same folder that 
the Word Document file is saved in.  You 
just might have need of them in the future. 

You are to place the three images in 
the same locations that you put them in the 
previous InDesign Template Assignment. 

Place your first image on the cover 
page.  To place an image in Microsoft Word, 
go to the file menu Insert  Picture.  A 
window will appear through which you can 
navigate and find your file. 

The image may automatically place 
in-line with the text, but you want to change 
it so that you can move it around and place it 
freely.  To do this you need to access the 
Format window for the image.  To get the 
Format window, select the image, then right 
click on it and chose: Format Picture.  From 
the menu that appears, choose the Layout 
tab.  The Layout for the front cover image 
will need to be set to “Behind Text.”  Your 
next two images will be set to “Square” or 
“Tight.”  You might need to select the Size 

tab and set it to 100% 
as it may have been 
changed when it was 
first place in-line with 
the text.  After you set 
the formatting for the 
picture, you should be 
able to click and drag 
your image to its 
intended location.  Be 
sure not to stretch or 
squish the image.  If 
you do you can go 
back into the Size tab 
and set the width and 
height dimensions 

back to 100%. 
If for some reason the image is behind 

the blue background then you will need to 
select the blue background and right click 
(MAC: hold down the  key).  This will 
bring up a quick menu in which you will 
choose Order  Send to Back.  If the 
image is on top of everything, including the 
title “Microsoft Word,” then you will need to 
select the title (make sure that it is not a text 
edit select but an object select) and right click 
(MAC: hold down the  key).  From the 
quick menu that comes up choose Order  
Bring to Front. This will position the title 
over the image, thereby sandwiching the 
image under the title and over the blue 
background.
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